
    


    
    Top
   
    







  
    
      
        
          
            
          
        
        
          
          
            PDFelement: PDF Editor, Scanner

            Edit, Convert, Annotate PDF

            Edit, Annotate PDF

          

        

      

      OPEN
      OPEN
    

  




  
    
      
        
          wondershare
        

        
          
            
          
          
            
          
        
        
          	
  
    Video Creativity
    
      
    
  
  
    
      
        Video Creativity Products

        
          
          
            Filmora
            Complete video editing tool.

          

        
        
          
          
            DemoCreator
            Efficient tutorial video maker.

          

        
        
          
          
            UniConverter
            High-speed media conversion.

          

        
        
          
          
            Virbo
            Powerful AI video generator.

          

        
        
          
          
            Presentory
            AI video presentation maker.

          

        
        View all products
      

      
        Explore

        	Overview
	Video
	Photo
	Creative Center


      

    

  


	
  
    Diagram & Graphics
    
      
    
  
  
    
      
        Diagram & Graphics Products

        
          
          
            EdrawMax
            Simple diagramming.

          

        
        
          
          
            EdrawMind
            Collaborative mind mapping.

          

        
        
          
          
            EdrawProj
            A professional Gantt chart tool.

          

        
        
          
          
            Mockitt
            Design, prototype & collaborate online.

          

        
        View all products
      

    

  


	
  
    PDF Solutions
    
      
    
  
  
    
      
        PDF Solutions Products

        
          
          
            PDFelement
            PDF creation and editing.

          

        
        
          
          
            Document Cloud
            Cloud-based document management.

          

        
        
          
          
            PDF Reader
            Simple and free PDF reading.

          

        
        
          
          
            HiPDF
            Free All-In-One Online PDF Tool.

          

        
        View all products
      

    

  


	
  
    Data Management
    
      
    
  
  
    
      
        Data Management Products

        
          
          
            Recoverit
            Lost file recovery.

          

        
        
          
          
            Repairit
            Repair broken videos, photos, etc.

          

        
        
          
          
            Dr.Fone
            Mobile device management.

          

        
        
          
          
            MobileTrans
            Phone to phone transfer.

          

        
        
          
          
            FamiSafe
            Parental control app.

          

        
        View all products
      

    

  


	Explore AI
	Business
	Shop
	Support
	
              Sign in
            
	
              
              
                
                Account Center
                Sign out
              

            


        

      

    

  
  
    
      
        
          
            
            PDFelement
          
        

        
          
            
          
          
            
          
        
        
          	
              
                Products
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Desktop

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  PDFelement for Windows
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Mac
                                
                              
	
                                
                                  
                                    
                                  
                                  PDF Reader for Windows
                                
                              


                          

                        

                        

                        
                          
                            Mobile App

                            
                            	
                                
                                  
                                    
                                  
                                  PDFelement for iPhone/iPad
                                
                              
	
                                
                                  
                                    
                                  
                                  PDFelement for Android
                                
                              
	
                                
                                  
                                    
                                  
                                  InstaScan - PDF Scanner for iPhone
                                
                              


                          

                        

                        

                        
                          
                            Cloud & SDK

                            
                            	
                                
                                  
                                    
                                  
                                  Document Cloud
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement Pro DC
                                
                              
	
                                
                                  
                                    
                                    
                                  
                                  PDFelement SDK
                                
                              


                          

                        

                        

                        
                          
                            
                              What's New
                            

                            
                            	
                                
                                  
                                
                              


                          

                        

                      

                    

                  

                

              

            
	
              
                Solutions
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Educational Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Read PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Annotate PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Create PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                  
                                  Combine PDF
                                
                              


                          

                        

                        

                        
                          
                            Personal Users

                            
                            	
                                
                                  
                                    
                                    
                                    
                                  
                                  Convert PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                  
                                  Edit PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                  
                                  Compress PDF
                                
                              
	
                                
                                  
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                    
                                  
                                  Organize PDF
                                
                              


                          

                        

                        

                        
                          
                            Professional Users

                            
                            
                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF Form
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Sign PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                    
                                    Protect PDF
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    Batch PDF
                                  
                                


                              	
                                  
                                    
                                      
                                      
                                      
                                      
                                      
                                    
                                    PDF OCR
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                      
                                    
                                    Extract PDF Data
                                  
                                
	
                                  
                                    
                                      
                                    
                                    AI-Powered PDF Tool
                                  
                                
	
                                  
                                    
                                      
                                      
                                      
                                    
                                    eSign PDFs Legally
                                  
                                


                            

                          

                        

                        
                          
                            
                              Industries
                            

                            
                            
                              	
                                  Education
                                
	
                                  IT Service
                                
	
                                  Legal
                                
	
                                  Healthcare
                                


                              	
                                  Financial
                                
	
                                  Government
                                
	
                                  Publishing
                                
	
                                  Freelancer
                                


                            

                          

                        

                      

                      
                        All PDF Features
                      

                    

                  

                

              

            
	
              
                Resources & Help
                
                  
                    
                  
                

              
              
                
                  
                    
                      
                        
                          
                            Hot Topics

                            
                            	
                                Top List
                              
	
                                Mac Software
                              
	
                                PDF Apps
                              
	
                                OCR PDF Tips
                              
	
                                Sign PDF Tips
                              
	
                                Edit PDF like Word
                              
	
                                PDF Converter Tips
                              
	
                                PDF Compressor Tips
                              


                            Find More Topics
                          

                        

                        

                        
                          
                            
                              
                                Why PDFelement

                                
                                	
                                    Customer Stories
                                  
	
                                    PDF Software Comparison
                                  


                              

                            

                            
                              
                                Better Use

                                
                                	
                                    Tech Specs
                                  
	
                                    Contact Support
                                  


                              

                            

                            
                              
                                User Guide

                                
                                	
                                    PDFelement for Windows
                                  
	
                                    PDFelement for Mac
                                  
	
                                    PDFelement for iOS
                                  
	
                                    PDFelement for Android
                                  


                              

                            

                            
                              
                                 

                                
                                	
                                    PDF Reader
                                  
	
                                    Document Cloud
                                  
	
                                    InstaScan for iPhone
                                  


                              

                            

                          

                        

                        

                        
                          
                            Explore More

                            
                            	
                                Reviews
                                See what our users say.

                              
	
                                Free PDF Templates
                                Edit, print, and customize free templates.

                              
	
                                PDF Knowledge
                                PDF-related information you need.

                              
	
                                Download Center
                                Download the most powerful and simple PDF tools.

                              


                          

                        

                      

                    

                  

                

              

            
	
              Upgrade
            
	
              Business
            
	
              Download
              Download
              Pricing
              Pricing
            
	
              
                
                  
                    
                    
                  
                
              
            


        

      

    

  


 




          
          
            
              
                
                  Edit PDF Solutions


  	
              
                  Editing Tips

              

              
                  	Free PDF Editor
	Free PDF Writer
	How to Edit File in PDF
	Open Source PDF Editor
	Spell Check PDF
	Copy and Paste from PDF
	Move and Align Objects
	Can't Edit PDF
	PDF Metadata Viewer
	Edit Metadata
	PDF Graphic Editors
	Flatten PDF
	 Online PDF Editor
	Flatten PDF Online
	Edit PDF in Chrome 
	Ubuntu PDF Editor
	Edit PDF on Linux
	Snapshot PDF


              

          
	
            
                PDF Watermark

            

            
                	PDF Watermark Remover
	Remove Watermark from PDF
	Add Logo to PDF
	Add Watermark in PDF
	Free Remove Watermark from PDF
	Online Remove PDF Watermark
	Watermark PDF Online


            

        
	
          
              PDF Background

          

          
              	Remove Background
	 Create PDF with Transparent Background
	Change Background Color
	Color PDF
	Add Background to PDF


          

      
	
        
            PDF Image

        

        
            	Add Image to PDF
	Add a GIF to PDF
	Flip a PDF Image
	Add PNG to PDF
	Remove PDF Image
	Edit PDF Image
	Paste Image into PDF
	Mirror Image in PDF
	Add Image to PDF Online
	Add Picture to PDF
	Crop Image in PDF
	Manage PDF Layers
	Insert Image to PDF
	Insert Picture into PDF
	Add Photo to PDF
	PDF Image Editor
	Insert Photo into PDF


        

    
	
        
            PDF Text

        

        
            	Edit PDF Text
	Insert Text into PDF
	Increase Font Size
	Edit PDF Font
	Change Font Color
	Copy Text from PDF
	Edit Font Size
	Select Text in PDF
	Delete Text from PDF
	Change Font in PDF
	Edit PDF Text Online
	Change Text Color
	Change Font Size


        

    
	
        
            PDF Link

        

        
            	Add Link to PDF 
	Hyperlinks Not Work in PDF
	Create URL for PDF
	PDF Link to Page
	Embed Video in PDF
	Edit Link in PDF
	Remove Link from PDF
	Create Link for PDF 
	Add Audio to PDF
	Add Video in PDF


        

    
	
        
            PDF Page Numbers

        

        
            	Add Page Numbers to PDF
	Add Header and Footer to PDF
	Remove Footer from PDF
	Add Bates Numbering
	Change Page Numbers in PDF
	Insert Page Number in PDF
	Start Page Number on Page 3
	 Add Page Numbers Online


        

    
	
        
            Translate PDF

        

        
            	Translate PDF
	Translate Scanned Document
	Google Translate PDF
	English to Hindi
	English to French
	French to English
	English to Spanish
	Spanish to English
	Japanese to English
	German to English


        

    


  Try It Free    Try It Free  Try It Free


                

              

              
                  
            

          
          


    
		
		  	  	    
      
    
		
      
        
          How to Add Watermark in PDF Files

        

      

      
        

          
            
              
            

            
              
                
                  
                    Margarete Cotty

                  

                

                
                  
                    2024-01-08 18:46:10 • Filed to:
                    PDF Watermark
                    • Proven solutions
                  

                

              

            

          

          Watermarks can serve a very important role. First, they act as a security tool for PDF documents, and second, they can act as an effective advertising tool. Therefore, adding a watermark to the PDF is usually a good idea. Now I will show you how to easily add watermark to PDF in three different ways.




	Part 1: Add Watermark to PDF(the Easiest Way)
	Part 2: Add Watermark to PDF Free
	Part 3: Add Watermark to PDF Online
	Part 4: Insert Watermark in PDF - FAQs 




How to Add Watermark to PDF

The easiest way to add watermark to PDF is using Wondershare PDFelement - PDF Editor.

PDFelement provides a pervasive set of tools for you to make appropriate edits. PDFelement is undoubtedly a very impressive option for adding watermark across PDF documents. It allows you to add different kinds of watermark to PDF, including draft watermark, confidential watermark, and image watermark to PDF.
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Step 1. Import Your PDF to Add Watermark

Launch PDFelement. Click the "Open files" button on the "Home" tab to select the file you wish to insert the watermark into.



Step 2. Insert Watermark in PDF

After opening the document, go to the "Edit" option and select "Watermark", and then click "Add Watermark" from the submenu. You will be presented with a new window.



Step 3. Add Watermark to PDF in Different Ways

Now, you can add watermark to PDF by typing Text or adding an image file. Here is how to add commonly-used watermark to PDF by using PDFelement.
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Add draft watermark to PDF: Type Draft in the Content box. Then you can preview how the draft watermark looks like in your PDF file. You can customize the font style, size, color, opacity and other settings before applying. Set up the proportion and position of the draft watermark in the PDF document.



Add confidential watermark to PDF: Type Confidential in the Content box to add a Confidential watermark in PDF. You can customize the watermark the way you like. When you are done, click Apply to add the confidential watermark to the PDF. You can also tick Add to template option so that you can use the watermark to other PDF files.



Add image watermark to PDF: Import an image as a watermark across the PDF document. Set up the position and other appearance settings before adding the image as a watermark. Set up an absolute scale or proportion of pages and position of the PDF page. You can even figure out the watermark's opacity and other appearance settings before adding it across the document.



Step 4. Apply Watermark in PDF

Once you add up an appropriate watermark, tap "Apply" to insert the watermark into the PDF document. Move to the "File" tab and select "Save" to conclude the process.

Tip: How to Batch Add Watermark in PDF Files

PDFelement also provides the option of adding watermarks to PDF in batches. If you have a set of documents that require a single watermark, you can follow the steps as explained below.
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Step 1. Access Batch PDF to Add Watermark

Launch PDFelement and tap on the "Batch PDF" option on the Home page.



Step 2. Upload PDF Files

Select “Watermark” from the left pane and add files across the platform by tapping the “Choose file” button. Add all the files that you wish to watermark. Once added, you are required to add the watermark across the documents.

Step 3. Add Watermark in PDF

Select "Add Watermark" and tap on the button below to add the watermark across the PDF documents from the set of options. Select the watermark type from Text, PDF, or Image. On selecting the appropriate type, set up the appropriate appearance settings and positioning of the watermark before applying the watermark. Once added, tap on "Apply" to execute the process.



Here are some other PDFelement's features:
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	You can convert a Word, Excel, HTML file, or other document types into PDF or vice versa.
	Edit PDF files to add or remove images, text, comments, and more.
	Add text, images, and files as a watermark to your PDF for copyright protection.
	You can add comments or highlight certain parts of the PDF file to highlight anything you want.
	Recognize text in a scanned PDF file and make the file editable with OCR technology.






How to Add Watermark to PDF Free

If your PDF files are text-based, which means the PDF files are initially created by software such as Microsoft Word, Excel, then you can easily add watermark to the PDF files for free using Microsoft Word. However, this won't work on image-based or scanned PDF files. To add watermark to scanned or image PDF, you should use PDFelement.

To add watermark to PDF for free, first open the PDF file in Microsoft Word. After then, go to Design > Watermark.

Add preset watermark to PDF for free: You can a selection of preset watermarks. Select a watermark and it will be added to the PDF file immediately.

Add custom watermark to PDF for free: You can also click the Custom Watermark option to create a new watermark for free. You may choose to add a image watermark or text watermark.



Tip: Opening a PDF file in Microsoft Word could change the formatting of the PDF file.





How to Add Watermark to PDF Online

There are numerous online solutions that the user can look for, adding a watermark to PDF documents. While looking into the right option, you can surely try out PDFCandy as the solution to add watermark to PDF. Follow the steps provided below to understand how to insert watermark in PDF.

Step 1: Open the official website of PDFCandy and select the “Add Watermark to PDF” tool in the available options. On opening the appropriate screen, tap on “Add File” to import the document onto the platform. You can also add documents from Dropbox and Google Drive.



Step 2: Once you import a PDF file, the platform provides you the option to add text or image watermark on it. You can also set the position of the watermark from the options provided.



Step 3: As you add an appropriate watermark in the PDF document, proceed to tap on "Add Watermark." With the successful addition of a watermark on the PDF, you can easily download the edited document on your device.



There are many online and offline options when it comes to adding watermark to PDF documents. Some people prefer using online tools due to their usability and flexibility. As users do not need to use editors, they prefer working on online solutions. While online tools have their benefits, offline PDF tools provide a much wider space in features and tools.

Also, many users prefer working on offline tools if they wish to make significant edits to their documents. The offline tool also provides them with the option of adding watermarks in PDFs without any internet connection. While searching for the best tool in the market, you may find PDFelement as the best offline solution to add watermark to PDF.
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Insert Watermark in PDF - FAQs

How to add watermark to PDF without Acrobat?

It is easy to add a watermark to PDF with Acrobat. However, many people don't have Acrobat on their computers since it is a pretty expensive PDF software. To add a watermark to PDF without Acrobat, you can use the more affordable Acrobat alternative - PDFelement. It is an easy-to-use PDF editor to add watermarks, text, images,s and more to PDF files. Or you can use an online service such as PDFCandy.

How to add watermark to PDF on Mac?

To add a watermark to a PDF on a Mac, you can use the built-in Preview application, which comes pre-installed on macOS. Preview enables you to watermark PDF on Mac by adding text. You can click and drag the watermark to position it where you want on the PDF page or resize the watermark by clicking and dragging its handles. You can also change the opacity of the watermark by clicking on it and selecting "Show Colors" from the "Format" menu. Here is a complete guide on how to add watermark to PDF on Mac.

Why Need to Add Watermark to PDF?

Watermark is considered important in a lot of scenarios. When the objective is to protect the authenticity of the data present across the document, a watermark is considered essential. In other cases, to protect documents from theft, it is considered safe to watermark PDF to keep them protected from theft.

Although most people are against adding watermarks to their PDF documents, there are a lot of benefits that can be counted relating to watermarks. Watermarks can effectively save your documents or digital assets from unauthorized use.
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